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1.0 Introduction 
 
This document provides a description for the use of the Environmental Data Graphical Evaluation 
Imaging System (EDGEIS) version 6.4. EDGEIS was developed under contract to the Forecast 
Products Development Team (FPDT) of the Office of Research and Applications (ORA) of the 
National Environmental Satellite, Data and Information Service (NESDIS) of the National Oceanic 
and Atmospheric Administration (NOAA). 
 
EDGEIS was originally developed to support the display of soundings and related grid files. Original 
versions only supported a single grid resolution (2.5 by 2.5 degrees). Later versions supported 
multiple grid resolutions as well as sequential data. All versions of EDGEIS prior to version 6.0 ran 
on the DOS operating system only. Beginning with version 6.0, EDGEIS is capable of running on a 
large number of operating systems using Java. 
 
 
1.1 Capabilities 
 
The primary purpose of EDGEIS is to display images that show horizontal cross-sections of the 
Earth’s atmosphere using data from NOAA weather satellites. The layout of the program was 
designed with this in mind and most program functions use horizontal images as a starting point. 
EDGEIS provides a variety of functions that are used to generate and manage horizontal images. 
 
Several utilities are available which allow images to be analyzed. One such utility is the ability to 
generate an image that shows the difference between two horizontal images. This is a useful tool that 
makes it easy to compare data from different systems. Other utilities that can be use to analyze data 
include a blinking function that will blink data that matches a specific value or a range of values. 
 
EDGEIS provides the ability to take a closer look at the data used to create horizontal images. Any 
location on an image can be selected to obtain additional data associated with the location. When 
this is done, a graph of all available profiles is displayed. Other raw data associated with the selected 
location is also displayed. 
 
In addition to horizontal cross-sections of the Earth’s atmosphere, it is possible to display vertical 
cross-sections of the atmosphere. These cross-sections can cut though the atmosphere between any 
two points on the Earth. When this is done, the vertical cross-sections will show any available profile 
data. 
 
 
1.2 New Features 
 
Version 6.0 introduced a significant number of changes to EDGEIS. The most significant of these 
changes is a complete redesign of the program. Prior versions only ran under DOS in full screen 
mode. EDGEIS now runs under most operating systems as a standard window-based program. While 
this forced the layout of the program to be changed, it also allowed for the addition of many 
improvements to the program. 
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Some of the more significant changes made to EDGEIS with version 6.0 include: 
 

1. The number of frames available is no longer limited by the amount of RAM reserved for the 
program. An unlimited number of frames is now possible, only limited by the amount of 
storage space. 

2. Prior versions of EDGEIS required data files to be in specific locations. Such files can now 
be located in any location that the user chooses. 

3. The number of colors used by EDGEIS is no longer limited to 256. The number of colors 
available will be the same as is used by the operating system. This greatly increases the 
flexibility that can be used with color ramps. 

4. A new file format is used which provides for increased capabilities. The older file format is 
still supported, but some new features of EDGEIS will not be available when using older 
format files. 

5. Data can be obtained from data servers, such as the Polar Orbiting Satellite Sounding 
Evaluator (POSSE). 

6. Prior versions only supported the Cartesian and Polar Stereographic map projections. 
Additional projections, including Orthographic and Mollweide, are now supported. 

7. It is now possible to blink a range of data. 
8. A graph of individual sounding profiles can be displayed by selecting any location on a 

horizontal image. 
9. An image that shows a vertical cross-section can be displayed by drawing a line across a 

horizontal image. 
10. Images can be saved using an unlimited number of resolutions. 
11. EDGEIS is now able to print directly to any printer. 

 
Changes made to EDGEIS since version 6.0 can be seen in Appendix F. 
 
 
1.3 Relationship To Posse 
 
At the same time that EDGEIS 6.0 was being developed, the Polar Orbiting Satellite Sounding 
Evaluator (POSSE) was developed. Both programs are very similar and share much of the same 
code. In fact, the primary purpose of both programs is to display horizontal images that are generated 
from environmental data files. The similarities between the two programs is intentional. 
 
POSSE was designed to be a simplified version of EDGEIS that would be used primarily by users 
outside of NOAA/NESDIS while EDGEIS would be used by NOAA/NESDIS users. Every feature 
that is contained within POSSE is also available to users of EDGEIS. POSSE, however, lacks some 
of the more advanced features of EDGEIS such as image differencing. Because POSSE is designed 
to be used as an applet, it contains security features that prevent it from doing some things that 
EDGEIS is capable of, including accessing local files. 
 
The similarity between the two programs allows for one of the new features of EDGEIS: the ability 
to access data from data servers such as POSSE. When creating or modifying an image in EDGEIS, 
the source of the data can come from a local file or from a POSSE server. This may often be useful 
since data from POSSE servers are updated shortly after each orbit is processed. This eliminates the 
need to create a new local file just to see the most recent data. 
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2.0 Installing EDGEIS 
 
Installing EDGEIS has been greatly simplified compared to earlier versions of the program. The 
entire program is contained within the file Edgeis.jar. This is a Java archive file, which is a file 
compressed using the standard ZIP format, that contains all of the code, file data and images used by 
the program. 
 
In order to install EDGEIS, all that is necessary is to copy the Edgeis.jar file to any location on your 
computer. The actual location does not matter, but for the sake of consistency it is probably a good 
idea to place it in the same location as other programs. For Windows users this will typically be the 
“Program Files” directory. For Macintosh users it will typically be placed within the “Applications” 
directory. 
 
 
2.1 System Requirements 
 
EDGEIS will run on any computer that is capable of running Java programs. This includes, but is not 
limited to, all versions of Windows, Mac OS X, Linux and most versions of Unix. 
 
There are no specific requirements concerning the amount of disk space that must be available. The 
program itself takes approximately 1 megabyte of space. The number of frames that are available 
will increase the amount of space used. Each frame will use between 500 and 1000 kilobytes. This 
amount is small enough that most users will not need to be concerned about disk space. The memory 
footprint used by EDGEIS will vary depending on the size of the main window. In most cases the 
program will require approximately 50 megabytes of memory. 
 
Internet access is not required to run EDGEIS, but if access is not available then it will not be 
possible to obtain data from a server such as POSSE. If data is accessed from a data server, a fast 
Internet connection is recommended. Image data sent by a server will usually be at least 1 megabyte 
per image. For dialup users, this will result in delays while the data is being sent. 
 
 
2.2 Obtaining And Installing Java 
 
In order for EDGEIS to run, Java must be installed on your computer. This section will provide a 
brief description of how to obtain and install Java. But it is the responsibility of each user to make 
sure that Java is installed correctly. 
 
To determine whether or not Java is installed on a computer, go to the command line and type the 
command:  
 

java –version 
 
 
 
 
 
 
 
 

Running EDGEIS On A Macintosh 
 

If you want to run EDGEIS on a Macintosh, you must use Mac OS X. Systems 9.x and earlier will not be 
able to run EDGEIS. If you are running OS X then you do not need to install Java because it will already be 
installed and set up by default. Should you wish to update your version of Java, you may do so by using 
Software Update or by visiting Apple’s Java page at http://www.apple.com/java/  
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If Java is installed, this command will generate a message that describes the version of Java that is 
installed. If Java is not installed, it will generate an error message stating that the command was not 
found. It should be noted, however, that it is possible for a command not found message to be 
generated even if Java is installed. This will occur when the java command is not located within the 
current path. If this is the case, then you will need to make sure that your path is updated to include 
the java command. 
 
If Java is not installed, it can be obtained by going to the web site: 
 

http://java.sun.com/ 
 
From this page you will need to locate the download. Look for the latest version of Java 2 Standard 
Edition (J2SE). If you have a choice between downloading the Java Runtime Environment (JRE) 
and the Software Development Kit (SDK) you should choose the JRE unless you plan to write your 
own Java programs. Once you download the program, the installation process will usually be 
straightforward. 
 
 
2.3 Running The Program 
 
There are two methods available for running EDGEIS. The first method is to go to the command 
line, switch to the directory that contains Edgeis.jar, and type the command: 
 
 java –jar Edgeis.jar 
 
The second way to run EDGEIS will usually be the easiest. On most operating systems all you need 
to do is double-click the Edgeis.jar icon just like you would if you were running any other program. 
This will kick off Java and start running EDGEIS. 
 
 
2.4 Default Directories 
 
EDGEIS uses a default directory structure to store various files that may be needed and to store 
temporary frames. This directory will be named “edgedir” and will be located in the same directory 
as the Edgeis.jar file. If the directory does not exist when EDGEIS is run, it will be created 
automatically. 
 
The edgedir directory will contain the following files and  directories: 
 

saved_state.dat This file contains information about the state of the program at the 
time that it was last run, including a list of available frames. If this 
file exists, it will be read and the previous state of the program will 
be restored. 

 
color_scales This directory contains custom color ramps. Any custom color 

ramp in this directory will be available within EDGEIS and may be 
applied to any image. 

 



 5 

label_files This directory contains custom label files. These files are used to 
override default label text and label colors. 

 
edge5 Versions of EDGEIS prior to 6.0 used label files. Although such 

files are not required by the latest version of EDGE files, they are 
still needed if old-format files are used. Because of this, all old-
format label files need to be placed in this directory. 

 
frames This directory can be used to store saved frames. Saved frames can 

be saved in any location, but this directory is included as a 
convenience. 

 
images This directory can be used to store saved images. Like the frames 

directory, images do not have to be stored in this directory. 
 
temp Temporary frames are placed in this directory by the program. 
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3.0 Using EDGEIS 
 
EDGEIS has been designed to function just like most window-based programs. The main window 
will typically appear similar to Figure 1. All of the program functions can be accessed from the 
menus at the top of the window. The bottom of the window contains controls that are used to change 
frames and switch between frames. 
 
 

 
Figure 1 – The typical layout of the main window. 

The actual look of the window may vary depending on the operating system 
used and the current look and feel of the program. 

 
 
 
Above the main image is a text field that contains a description of the current frame. This description 
can be changed at any time by entering a new description in the field and pressing the return key. To 
the left of the frame description field is the name of the file that contains data used by the current 
frame. 
 
The main part of the window contains one to four images. Information about the images is shown at 
the top of each image. Underneath each image is a color scale that shows which values are 
represented by the various colors. 
 
On the left side of the main window is a toolbar. All program functions in the toolbar are also 
available from the menus. But the toolbar provides quick access to frequently used functions. The 
icons in the toolbar perform the following functions: 
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New Frame. Creates a new frame and inserts it immediately after 
the current frame. 

 

Open Frame. Opens a frame from a file and inserts the frame 
immediately after the current frame. 

 

Close Frame. Removes the current frame. 

 

Save Frame. Saves the current frame to a file. If the frame has 
been previously saved, it will be resaved to the same file. If the 
frame has not been saved, a dialog will appear into which the 
name of the frame can be entered. 

 

 

 
The arrow icon returns the program to its default state. When 
other functions, such as zooming, are done the program will 
remain in that state. This will turn the other function off. 

 

 

 
This icon turns on the “zoom in” function. After clicking this 
button the cursor will turn into a magnifying glass with a plus 
sign. 

 

 

 
This icon turns on the “zoom out” function. Clicking this button 
will cause the cursor to change to a magnifying glass with a 
minus sign. 

 

 

 
Clicking this icon will turn on the profile selection function. After 
it is clicked the cursor will change to a hand with a profile graph 
on top of it. 

 

 

 
This is the vertical slice icon. After it is clicked the cursor will 
change to a hand with a slice image on top of it. It will then be 
possible to create a vertical cross-section. 

 

 

 
This toolbar icon turns blinking on or off. If there is no blinking 
happening when this is clicked, a dialog will appear that provides 
the ability to blink a range of data. If this is clicked when 
blinking is occurring then the blinking will stop. 
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This icon provides a quick way to access the image differencing 
function. Once clicked it will be possible to selected two images 
to difference and a place to put the resulting image. 

 

 

This icon can be clicked to refresh all of the images in the current 
frame. After it is clicked each image will be recreated. This will 
usually be done to recreate the image in order to pick up any new 
data that may have become available since the last time the image 
was created. It may also be used to redraw the images after the 
size of the main window has been changed. 

 
 
3.1 Frame Management 
 
EDGEIS is designed around the concept of a frame. A frame is an object that holds one or more 
horizontal images. With EDGEIS it is possible to switch between frames as well as add, delete, save 
and open frames. This allows for the creation of new images while older images can be kept around 
for later viewing. 
 
Information and data associated with each frame are stored in a frame file. In most cases, the typical 
user will not need to be concerned about the actual name and location of the frame files. The 
following information is provided, however, because it may occasionally prove useful to understand 
the method used by EDGEIS to manage the frames. 
 
When a new frame is created it is initially stored in a file in the /edgedir/temp directory. The file 
name that the frame is stored under uses the form: default_window_yyjjjsssss.frm, where yy is the 
two digit year, jjj is the julian date, and sssss is the second of the day. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Frame Management In Earlier Versions Of EDGEIS 
 
Versions of EDGEIS prior to 6.0 used a predetermined number of frames. The actual number of frames 
was set either during EDGEIS installation or using a manual setup program. Depending on the number of 
frames, a certain amount of the computer’s memory would be reserved for use by EDGEIS. When the 
program was run, each frame was read from disk and stored in memory. This allowed for fast switching 
between frames. The primary drawback of this method involved the manner in which the computer’s 
memory was reserved. In particular, changes had to be made to the config.sys file in order to set aside a 
specific amount of extended memory which would be used when EDGEIS was run. This worked fine 
initially, but with each successive version of Windows, it became more difficult to make this work. 
 
Beginning with EDGEIS 6.0, the method of managing frames has been completely changed. Instead of 
reading each frame into memory, the frames are kept on disk. Only the current frame and previous frame, 
if available, are saved in memory. Although this results in a small time delay when switching frames, it 
eliminates all of the problems associated with keeping the frames in memory. 
 
In EDGEIS 6.0, there is no predetermined number of frames. The program begins with one empty frame 
when it is run for the first time. The user may then add and remove frames at will. The maximum number 
of frames is only limited by the amount of storage space on the local computer. 
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Using such a naming convention for each frame assures that each temporary frame has a unique file 
name. It also indicates when a given frame was created, which could help in identifying frames. 
 
The file that the frames are stored in remains in the Temp directory until it is closed or the frame is 
saved under a different name. When EDGEIS is exited, it first checks the files in the Temp directory 
and removes all files that are no longer associated with current frames. This prevents a buildup of 
unused frames in the Temp directory. 
 
 
3.1.1 Adding New Frames 
 
A new frame can be added at any time by selecting “New” from the File menu or by clicking the 
“New Frame” button at the bottom of the main window. A dialog will appear (Figure 2) which 
shows 4 panels, one of which will be blue. This dialog will allow you to choose the number and 
layout of images within the frame. 
 
 

 
Figure 2 – New Frame Dialog 
 
Before a new frame can be created,  
it is necessary to tell EDGEIS how 
many images the frame will contain. 
This dialog allows you to do that by 
clicking or dragging the mouse on  
the colored squares. The blue  
squares show the number and  
layout of images in the frame. 
 
The description of the frame can  
be added by entering it in the  
description field. 
 
 
 
 
 
 
 

 
 
Each frame may contain 1 to 4 images. The layout of these may be a single image (1x1), two images 
side by side (1x2), two images arranged vertically (2x1), or 4 images (2x2). The layout can be 
selected by clicking or dragging the mouse anywhere within the boxes in the dialog. As this is done, 
the various boxes will change between gray and blue. Te blue boxes show the current number of 
images and their layout. 
 
In addition to the 4 boxes, the dialog also contains a text field that allows you to enter a description 
of the frame. It is not necessary to enter a description (“Untitled” will be used as a default). But 
adding a description can prove useful when attempting to locate a particular frame among many 
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open frames. If a description is not provided here, it can be changed from within the frame itself at a 
later time. 
 
 
3.1.2 Opening A Saved Frame 
 
Frames that have been saved can be reloaded by selecting “Open” from the File menu. An open file 
dialog will be displayed from which the name of a saved frame can be selected. After a frame file is 
selected, it will be opened and inserted immediately after the current frame. The newly opened frame 
will then become the current frame. 
 
3.1.3 Saving A Frame 
 
The current frame can be saved at any time by selecting either “Save” or “Save As” from the File 
menu. If the frame has not been saved under a different name (i.e, it still uses the 
e6fmmddyyyhhmmss.frm naming convention), then “Save” and “Save As” will both cause a save 
file dialog to appear. This dialog can be used to select a directory and file name to save the frame 
under. By default the Frame directory is initially chosen as the directory to save the frame in. The 
frame may be saved in this directory or any other directory. 
 
If the current frame has been saved previously, then choosing “Save” will automatically save the 
frame without displaying a save file dialog. The frame is saved using the previously selected file 
name. 
 
 
3.1.4 Removing A Frame 
 
When “Close” is selected from the File menu, the current frame is removed from the list of available 
frames. If the frame has not been previously saved (i.e., it still uses the e6fmmddyyyyhhmmss.frm 
naming convention), then a dialog will appear that asks whether or not the frame should be saved 
before it is removed. If “Yes” is selected, a save file dialog will appear which allows the frame to be 
saved under a new name. If “No” is selected, the file is removed from the list of available frames and 
will be permanently deleted. If “Cancel” is selected then the frame is not removed. 
 
 
3.1.5 Copying Frames 
 
There are occasions when it is useful to make a copy of a frame in order to use the frame’s settings 
in another frame without the need to re-enter all of the settings manually. EDGEIS provides two 
methods for doing this. When a frame is copied, the copy is initially identical to the original frame in 
every way except for its location within the list of available frames. 
 
Located under the File menu are two commands: “Copy Frame” and “Copy Frame To”. The “Copy 
Frame” command will create a copy of the current frame and will insert the copy immediately after 
the current frame. The “Copy Frame To” command also makes a copy of the current frame. Before 
the frame is copied, however, a dialog containing a list of frames (excluding the current frame) will 
be displayed. After a frame is selected from the list, the current frame will be copied. Unlike the first 
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copy command, the new frame will not be placed after the current frame. Instead, the frame that was 
selected in the dialog will be replaced with the copy. 
 
 
3.1.6 Switching Between Frames 
 
When EDGEIS contains more than one frame it is possible to switch between all of the available 
frames. The switching can be done using several methods: 
 
Left/Right arrow buttons Using the mouse, the left and right arrow buttons can be used to switch 

frames. These buttons are located near the lower right corner of the 
main window. The left arrow button causes the frame that precedes the 
current frame in the list of available frames to be displayed. The right 
arrow button causes the succeeding frame to be displayed. 

 
Left/Right arrow keys The left and right arrow keys on the keyboard can also be used to 

switch frames. They function in the same manner as the left and right 
arrow buttons. 

 
Page Up and Page Down These keys on the keyboard can also be used to switch frames. The 

Page Up key selects the frame after the current frame. The Page Down 
key selects the frame before the current frame. 

 
Entering the frame number Near the lower right corner of the main window is a text area that 

contains the current frame number. By entering a different frame 
number in the text area and hitting the Enter key, the frame matching 
the entered number becomes the current frame. 

 
Using the drop down list To the left of the arrow buttons is a drop down list that contains the 

descriptions for every available frame. A new frame can be chosen by 
selecting it from this list. 

 
 
 
 Figure 3 – Frame Switching Controls 
 
 The controls used to switch between frames  
 are located at the lower right of the main  
 window. Any of these can be used to select  
 a frame to display. The left and right arrow  
 keys and the page up and page down keys  
 can also be used to switch frames. 
 
 
 
 
3.2 Creating And Modifying Horizontal Images 
 
Horizontal images are created and modified using the data selection dialog (Figure 4). To bring up 
the dialog, you can press the “Select Data” button at the bottom of the main window or press the F4 
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key. The dialog contains a collection of controls for each panel in the current frame. In each panel 
within the dialog the controls on the top, from the data source buttons to the time window, are used 
to indicate which data is to be used to create the image. The remaining controls are used to indicate 
how that image is to be displayed. 
 
Prior to Version 6.3, all of the image generation controls were contained in a single panel. The 
addition of new controls did not leave enough room for all of the controls to fit. So the controls have 
been split into two tabbed panels. To toggle between the two panels, click on either the “Data” or 
“Layers” tab at the top of the data selection dialog. The “Data” panel contains controls that 
determine what data will be used in the image and how it will be displayed. The controls in the 
“Layers” panel affect the display of the various layers in an image. Each layer contains additional 
information that is overlaid on top of the image such as coastline data and grid lines. The layer 
controls are also accessible by using the right-click contextual menu and selectin “Adjust Layers.” 
 
Even with the data selection controls split into two tabbed panes, it is sometimes the case that there 
is not enough room to fit everything. EDGEIS will attempt to make everything fit by reducing the 
font size but this may make the text difficult to read. This problem can be reduced by resizing the 
dialog to make it bigger. 
 
 
 
 

 
Data Panel Controls: 
 
Change Current Image: 
The checkbox at the top controls whether or not the image that is represented by the panel is to be 
changed. This is used primarily when the current frame contains more than one image. This allows 
some images in a frame to be changed while others remain unchanged. If this box is unchecked and 
the panel already contains an image then the image will not be changed or updated. If the panel does 
not contain any image and the box is unchecked, then the panel will remain empty. 
 
 

Using Contextual Menus (Right-Clicking) 
 
EDGEIS 6.0 introduces a new way to perform certain  
functions. By right-clicking on any panel or image, a contextual 

menu will appear. If any of the menu items are selected,  
then the chosen function will apply only to the panel that was  
clicked on. For example, if you have a frame that contains  
4 quadrants, pressing the “Select Data” button will bring up  
a data selection dialog that applies to all 4 panels in the frame.  
But right-clicking on one of the panels and choosing  
“Select Data” will bring up a data selection dialog that only  
applies to the selected panel. 
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Local File/Data Server: 
EDGEIS is able to obtain data from two types of sources. The first type of source is “local file”. This 
is a file that resides on the local computer or network and is accessible in the same manner that files 
are available for other programs. The second source of data is “data server”. A data server is a 
program that resides on a remote computer. EDGEIS can contact the data server, request specific 
data, and then receive and process the data sent by the server. 
 
The “Local File” and “Data Server” radio buttons are used to select the source of the data. If the 
local file button is selected then underneath the data source buttons will be a button for selecting the 
local file along with the name of the file if one has been selected. If the data server button is selected 
then two drop-down lists will appear that allow for the selection of a data server. 
 
 
Select File button: 
When clicked, the select file button will bring up a file dialog. From this, a file can be selected. After 
a file is selected the name of the file will appear next to the select file button. 
 
 
Data Server lists: 
Two drop-down lists appear when data server button is selected. At any time there may be one or 
more data servers available from which data can be retrieved. A list of available servers appear in the 
first drop-down list. The second list contains the names of all satellite systems available on the 
selected data server. 
 

 
 
 
Parameter list: 
When a source of the data is selected, a list of available parameters will appear. This list contains the 
names of every available parameter. 
 
 
Orbital Node: 
If the source of the data contains orbital node values, it is possible to restrict the display of the data 
to only show either the ascending nodes or the descending nodes. This is done by selecting the 
appropriate radio button. If the “Both” button is selected, then all of the data will be displayed 
regardless of the orbital node. 
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Figure 4 – The Data Selection Dialog. 

The controls at the top of the dialog are used to select the source of the data used to create the image. 
The controls at the bottom are used to change the manner in which the data is displayed. 
If the frame contains more than one image, this dialog will be divided into panels, each of 

which will represent the corresponding image in the frame. 
 
 
 
Time Window: 
The time window controls are used to restrict the amount of data displayed. By default, all of the 
data from the chosen source of data will be displayed. If the time window list is set to 6 hours, 12 
hours, 18 hours or 24 hours, then the only data to be displayed will be data that falls within the 
previous selected number of hours. For example, if the time window is set to 12 hours and the 
current time is 1400 local, then only the data that falls between 0200 local and 1400 local will be 
displayed. 
 
The time window controls provide great flexibility when limiting the amount of data displayed. The 
flexibility, however, comes at the cost of potential confusion. Because the end of the time window is 



 15 

based on the current time, it is possible for the amount of data displayed in an image to change even 
though the time window has not been changed. This will occur at the top of every hour. 
 
 
Map Projection: 
 
Each image can be displayed using one of five available projections. The projection is selected by 
picking the desired selection from the drop-down list. Depending on which projection is selected, 
one or more controls to the right of the drop-down list will be enabled. The ones that are enabled 
provide more flexibility in displaying the image. 
 
For more information about each projection, see Appendix E. 
 
 
Data Range: 
The minimum and maximum values in the color scale can be adjusted using the data range controls. 
There are two options available. The first option is the automatic option. When this is selected, the 
actual minimum and maximum values in the data will be used as the endpoints of the color scale. 
The second option is the manual option. When this is selected, the low and high text fields will be 
enabled. Values entered in these fields will then be used as the endpoints of the color scale. 
 
 
Display Type: 
Most horizontal images are displayed using sequential as the display type. A sequential image shows 
individual spots for each data point. Another option is to display the data as gridded. Such images 
divide the Earth into variable sized grids. Each grid is displayed as a rectangle on a horizontal image. 
 
Some files contain data that are already in a gridded format. Images can be generated from these 
files but only as gridded images using the grid size from the file. 
 
For those files that are not in gridded format, it is possible to create images that are either sequential 
or gridded by selecting one of the display type radio buttons. If the sequential button is selected then 
the data will be displayed as is. If the gridded button is selected then each data point will be assigned 
to a grid and the grid will then be displayed. The horizontal and vertical size of the grid can be 
changed by entering values in the appropriate text fields. The values can range from 0.1 degrees up 
to 90 degrees. 
 
 
Smoothing/Contour: 
In default mode, each data footprint is drawn on the image using the footprint size. There are times, 
however, when it may be desirable to smooth the image. This is done by adjusted the smoothing 
controls. 
 
The first drop-down list controls the amount of smoothing applied to the image. EDGEIS smoothes 
images by applying area-averaging to each pixel in the image. In other words, an average of the 
pixels around a particular pixel is calculated and the value of the pixel is set to the average. The 
amount of pixels used in the averaging can be changed by setting the smoothing to a value between 1 
pixel and 10 pixels. The greater the number of pixels, the greater the smoothing will be. 
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The second drop-down list controls the type of smoothing. If “smooth” is selected, then smoothing 
will be applied to every pixel in the image. If “fill only” is selected, smoothing will only be applied 
to those pixels that do not already contain data. 
 
In addition to smoothing, the number of colors used in the image can be changed to a value between 
2 and 240 by changing the value in the contour field. When this value is set to a relatively small 
number the image, in effect, becomes contoured. This can be especially effective when combined 
with smoothing (Figure 5). 
 
  

 
Figure 5 – Smoothing And Contouring. 

Applying both smoothing and contouring to an image can produce dramatic and often useful results. 
The image on the left shows an unsmoothed image with no contouring. 

The image on the right shows the same data with a high amount of smoothing and a contour of 20. 
 
 
 
Color Ramp: 
Each parameter has a default color ramp associated with it. The selected ramp can be changed to 
another ramp by picking a different ramp from among the list of ramps in the color ramp drop-down 
list. The list will contain the default ramp and two grayscale ramps. If any custom color ramps are 
located in the color_scales directory, then they will also be contained in the drop-down list. 
 
 
Label File: 
This drop-down list contains all label files that are available in the label_files directory. If a file is 
selected, the labels from the file will override the default labels read from the file.  
 
 
 
Difference Image Selection: 
Within the data selection dialog it is possible to create a difference image. To the right of the data 
source controls is an identical set of controls. These are used to select a source of data to difference 
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with the source of data on the left. The controls on the right provide the same function as the 
corresponding controls on the left. 
 
The source of data on the right may be the same as that on the left or it may come from a different 
file or data server. If it is desired to use the same data source on the right that is being used on the 
left, the arrow button can be clicked. This will copy the data source from the left to the right. 
 
 

 
 
 
The first item in the parameter list on the right will be “No Difference.” When this is selected no 
difference image will be created, regardless of whether or not a data source has been selected on the 
right. If a difference image is wanted, then a parameter should be selected from the list on the right 
side. 
 
When a difference between two parameters is done, an image will be created that will show the 
difference between the data on the left and the data on the right. The difference image will show the 
left values minus the right values. 
 
 
 
Layers Panel Controls: 
 
Layer 0 (Background): Layer 0 is the background layer. By default, the background is black. This 
can be changed by adjusting the layer 0 controls. Radio buttons are used to toggle between the 
default color (usually black) and a selected color. If the “Selected Color” button is selected, the 
background color will be the color that is show in the box that is next to the “Pick Color” button. 
This color can be changed by clicking the “Pick Color” button. A color selection dialog will appear 
from which a new color can be choosen. 
 
Another option for the background is to insert an image on the background. This is done by selecting 
the “Use Image” box and then clicking the “Select Image” button. An open file dialog will appear 
from which an image can be selected. The image will be drawn onto the background of the image 
and will appear behind the data (figure XXX). If necessary, the image can be drawn at a specific 
location by entering values in the longitude and latitude fields. 
 
 
Layer 1 (Data Mask): The ranges for data masking are entered using the layer 1 controls. The first 
“from” and “to” text boxes are used to enter the data range for the first mask range. The second 
group of text boxes can be used to enter a second data mask range. 
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The “Pick Color” button is used to select a color to use when displaying masked data. The current 
color appears to the left of the button. 
 
 
Layer 2 (Coastline): The coastline layer controls the display of continental coastlines. The coastline 
can be turned on by checking the “Show Layer” box. The color of the coastline can be selected by 
choosing “Selected Color” and picking a color using the “Pick Color” button. If “Default Color” is 
selected, the color used for the coastline will be the color defined in the chosen color ramp. The 
thickness of the coastline can be changed by selecting a value from the drop-down list. 
 
 
Layer 3 (Geo-Political): The geo-political layer controls the display of geo-political boundaries such 
as state and countries. The controls used for this layer are the same as the controls in layer 2. The 
exception is the addition of the “Automatic” display option. When this option is selected, the geo-
political boundaries will not be displayed when the entire Earth is visible and will be displayed when 
only part of the Earth is visible (when zooming). 
 
 
Layer 4 (Grid Lines): The controls in layer 4 affect the display of grid lines.  
 
 
 
 
 
Map Type/Color: 
The type of map and the color of the map are adjusted using the map type and color controls. Two 
checkboxes are used to turn the map types on or off. If the coastline box is selected, then the outlines 
of the continents will be drawn on top of the image. If the political box is selected, geo-political 
boundaries such as states and countries are draw on top of the image. 
 
Each parameter uses a default map color. This color can be changed by picking another color from 
the list of colors that is located to the right of the political checkbox. 
 
 
Grid Lines: 
Grid lines will be drawn on top of the image at selected latitudes and longitudes if the grid line 
checkbox is selected. The distance between the grid lines can be adjusted by changing the values in 
the latitude and longitude fields. 
 
 
 
 
3.3 Zooming In and Out 
 
Zooming, both in and out, can be applied to any horizontal image. Zooming is turned on by selecting 
the appropriate menu item under the Tools menu or by clicking the appropriate icon in the toolbar. 
After zooming is turned on the cursor will change to a magnifying glass with either a plus sign or a 
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minus sign, depending on the zooming direction. At this point, any location on the image can be 
clicked on and zooming will occur at the selected position. 
 
When zooming in, the zoom amount will be increased by a factor of 2. After the image is rebuilt, 
zooming can be performed again and the zoom amount will again be increased by a factor of 2. 
 
Zooming out behaves in the same manner as zooming in, except that the zoom amount is decreased 
by a factor a 2 each time it is done. If it is no longer possible to zoom out any further, zooming out 
can still be done but will not have any effect on the zoom factor. It will, however, have an effect on 
the image. Because the map is centered on the selected location after each zoom, zooming out when 
the entire Earth is visible will essentially re-center the map on the selected location. 
 
If several levels of zooming in have been applied to an image, it is possible to zoom all of the way 
out in one step. This is done by pressing and holding the Control key while clicking on the image. 
 
 
3.4 Viewing Values At Selected Locations 
 
The exact value at any location in an image can be displayed at the bottom of the main window. This 
is done by clicking on the image. The location and value of the spot that is clicked on will appear at 
the bottom of the main window. 
 
Another way to view individual values is to press and hold the shift key while moving the mouse 
over the image. This will result in the location and values being updated continuously as the mouse 
is moved. 
 
 
3.5 Math Functions 
 
Comparisons between two images or sources of data can be done through the use of math functions. 
These functions can be used to add, subtract, multiply or divide to images. They can also be used to 
add, subtract, multiply or divide the values in an image by a constant value. 
 
 
3.5.1 Difference Images 
 
The math function that is the most likely to be used is the difference function. This function will 
subtract the values in one image from those in another image. This will effectively show the 
difference between the two images at each value location. 
 
 
 
 
 
 
 
 
 

Applying Zooming, Profile Selection and Slice Selection To All Images In A Frame 
 
If a frame contains more than one image, there will likely be times when you want to apply zooming to each 
image in the frame instead of just one. This can easily be done by pressing and holding the Shift key while 
clicking on any on of the images. If this is done, each image will be recreated and will use the selected 
image’s zoom factor to determine the amount of smoothing. As a result, each image will show the same 
amount of zooming and will also show the same Earth location. 
 
Pressing and holding the Shift key also works when selecting individual profiles and vertical cross-sections. In 
these cases, holding down the Shift key and making the appropriate selection will result in profiles and vertical 
cross-sections from each image in the frame. 
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There are two methods available to difference two images. The first method is to use the data choice 
dialog to pick two sources of data (see section 3.2). The other method is to select differencing, either 
by choosing “Subtract Plots” from the Tools menu or by clicking on the difference icon in the 
toolbar. Once this is done, the cursor will change to a hand with “1” on top of it. At this point, click 
on one of the images. The cursor will now change to a hand with “2” on it. The second image can 
now be chosen. After the second image is chosen the cursor will change to a hand with “To” on it. 
An empty panel or an existing image can now be clicked on in order to select a destination for the 
difference image. 
 
Difference images are created by subtracting the values of the second image from those of the first 
image at each pixel (image 1 minus image 2). The settings of the difference image will match those 
of the first image. For example, suppose the first image is being displayed using the Cartesian 
projection and is zoomed in on the United States while the second image uses he Mollweide 
projection and shows the entire Earth. A difference image between these two would use the settings 
of the first image and will use a Cartesian projection with the same zooming as the first image. This 
eliminates the need to make certain that the two images show exactly the same thing before the 
comparison is done. 
 
 
3.5.2 Other Math Functions 
 
In addition to the difference function, other math functions can be applied to an image. These 
functions are available under the Tools menu. The functions that apply math calculations between 
two images are handled in the same manner as the difference function. Once a function is selected, 
the cursor will change allowing the first image, then the second image, and then the target panel to 
be selected. 
 
The four math functions that apply a constant value to an image are used in a way that is similar to 
the functions used for two images. Once selected, a dialog will appear that will ask for the constant 
value. Once this value is entered the cursor will change to a hand with “1” on it. At this point it is 
possible to click on the original source image. After this the cursor will change to a hand with “To” 
on it. The target panel can now be chosen. 
 
 
3.6 Blinking 
 
Two types of blinking can be applied to images within EDGEIS. One type of blinking is to have 
individual data values blink. The other type of blinking is to have a range of data blink. If either of 
the two types of blinking is done, the pixels that represent blinking values will alternate between the 
background color and the original pixel color. 
 
The blinking will continue indefinitely until it is turned off. Because blinking is designed as a 
toggled function, it is either on or off. The first time that blinking is selected it will be turned on. The 
next time that it is selected, blinking will be turned off. The third time it is selected it will be turned 
on again, and so on. Blinking can be turned on and off in three ways: 
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1. Choosing “Select Blinking Data Range” from the Tools menu, 
2. Clicking the blinking icon in the toolbar, or 
3. Pressing command-b. 

3.6.1 Blinking A Range Of Data 
 
When blinking is turned on, a dialog will appear that contains one panel for each panel in the current 
frame (Figure 6). The top of each panel contains three radio buttons. If “Blink the selected data” is 
selected, then all data that lies between the “from” value and the “to” value will blink. If “Blink the 
non-selected data” is selected, then all data that is less than the “from” value and greater than the 
“to” value will blink. When “Don’t blink the data” is selected none of the data will blink. This will 
normally be done when the current frame has more than one panel and it is not desirable to blink the 
image in one of the panels. 
 
 

 
 

Figure 6 – Data Range Blink Dialog. 
 

When the blinking function is turned on, this  
dialog appears and will contain a panel for each 
image in the frame. 
 
The radio buttons at the top let you decide  
whether or not to blink the data and lets you  
pick which data to blink. 
 
The middle controls let you pick the specific  
data to blink or not blink. Checkboxes will  
appear for any special data contained within the 
image, such as clear or cloudy. 
 
The rate of blinking can range from 0.1 seconds 
(very fast) to 10 seconds (very slow). This is  
changed by adjusting the slider. 
 
 

 
Beneath the radio buttons are controls that are used to select the range of data to blink. The “from” 
and “to” fields will initially contain the minimum and maximum data values from the image. If the 
image had been set to blink previously, these fields will contain the most recent blinking range. If 
the image contains special data, such as clear values, then a checkbox will be present for each 
special value. After any special values are two checkboxes for out of range data. 
 
At the bottom of the panel is a slider that can be used to adjust the rate of blinking. The blinking rate 
can be set as fast as 0.1 seconds and as slow as 10 seconds. 
 
 
3.6.2 Blinking Selected Values 
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Individual data values can be set to blink by double-clicking on the color scale beneath the image. 
The value that is clicked on will become the blinking value. The image will continue to blink until 
blinking is turned off. 
 
While an individual value is blinking it is possible to switch to another value without having to turn 
the blinking off first. One way to do this is to double-click on another value in the color scale. A 
second way is to press either the “<” key or the “>” key. When the “<” key is pressed, the next 
blinking value will be the value that immediately precedes the current value. Likewise, the “>” key 
will set the next blinking value to be the value that succeeds the current value. 
 
 
3.7 Color Ramps 
 
Every parameter displayed by EDGEIS uses a color ramp to define which colors are used to 
represent the data. The color ramp used for a particular parameter is set in the file that the data is 
read from and is used by default. But the default ramp can be replaced by certain pre-defined ramps, 
such as grayscale, or by custom color ramps created by the user. 
 
One of the options contained in the data selection dialog is a control for the color scale. This list 
contains an option for the default scale and two grayscale options. It also may contain user-created 
custom color ramps. The custom ramps, if available, will appear at the end of the list (Figure 7). 
Custom ramps will appear in the list if they are located in the “/edgedir/color scales” directory. 
 
 

 
 

Figure 7 – Selecting Custom Color Ramps. 
The color ramp section of the data selection dialog contains the default ramp, two grayscale ramps, and zero  

or more custom ramps. The custom ramps in the list are read from the /edgedir/color scales directory. 
They can be applied to the image just like any other ramp. 

 
 
A custom color ramp can be created at any time by right-clicking on the image and choosing 
“Modify Color Ramp” from the pop-up menu. Doing this will create a dialog that provides the 
ability to change any of the colors in the current ramp (Figure 8). 
 
 
 
 
 
 
 

256 Color Values 
 

EDGEIS uses 256 colors for each ramp. 240 of the colors (colors 0 to 239) are used with continuous data 
such as temperature values. 10 colors (240 to 249) are used for special non-continuous data such as clear 
areas or terrain values. Colors 250 and 251 are used for data that exceed the range of the color scale, either 
low (250) or high (251). Color 252 is not used at this time. Color 253 is the color used to draw coastlines 
and political boundaries. Color 254 is the background color (normally set to black) and Color 255 (normally 
set to white) is the foreground color used for text. 
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The 256 rectangles on the right side of the dialog show the current colors for each of the 256 indices 
of the color ramp.  The color rectangles along the bottom row represent the 10 special values, the out 
of bounds low and high colors, the coastline color, and the background and foreground colors. 
 
Any one of these can be changed by clicking on the rectangle. When a rectangle is chosen, the index 
value underneath it will turn white. A new color can then be chosen using one of several options. 
The first option for picking a color is to click or drag the mouse on the round color wheel. As the 
mouse is clicked or drag, the color in the chosen rectangle will change to reflect the new color. As 
the color changes, you will notice that the sliders underneath the color wheel move. These sliders are 
another way to pick the color. The top three sliders represent the red, green and blue components of 
the color. The bottom three sliders represent hue, saturation and brightness. A third way to pick the 
color is to enter appropriate values in the text fields next to the sliders. 
 
 
 
 

 
Figure 8 – Color Ramp Dialog. 

Custom color ramps can be created by changing one or more of the 256 colors values. Colors values are  
changed by selecting one of the color squares on the right and then changing the color. The colors are  
changed by using the color wheel or one or more of the sliders. A continuous range of colors between  
two color values can be created by clicking the “Fill” button and then the first and last color squares. 
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Because most color ramps use colors that gradually change, such as yellow to orange to red, an 
option is available to automatically calculate the colors between to colors. To do this, click on the 
“Fill” button. This will change the cursor to a hand with “From” on it. Next, click on the color 
rectangle that you want to start from. Once this is done the cursor will change to “To”. At this point, 
click on the color rectangle that you want to end at. When this is done, all of the rectangles between 
the two chosen colors will fill with colors that change smoothly between the two selected colors. 
 
When using the fill option, it is important to understand the direction in which the fill is done. On the 
round color wheel, there is a line going from the center to the right side of the wheel. This line shows 
the division between the colors. As an example, assume that the fill function is being done between 
purple (at 2 o’clock on the color wheel) and orange (at 4 o’clock). When the fill is done, the colors in 
between these two colors will not change from purple to red to orange. Instead, the colors will 
change from purple to blue to cyan to green to yellow to orange. This is because the direction of the 
fill never crosses the dividing line. 
 
The name of the color ramp can be changed by entering a new name in the color ramp description 
field. The name in the field is used to describe the ramp within the data selection dialog. 
 
After the colors have been changed, a preview of the new color ramp can be seen by clicking the 
“Update Image” button. This will change the original image using the altered ramp. The changes can 
be accepted by clicking the OK button. 
 
After a new ramp has been created it can be saved by right-clicking the image and selecting “Save 
Color Ramp” from the pop-up menu. The color ramp can be saved in any location, but in order for it 
to be available in the data selection dialog the ramp needs to be saved in the “/edgedir/color scales” 
directory. 
 
A custom color ramp can be removed at any time by right-clicking the image and selecting “Use 
Default Color Ramp” from the pop-up menu. This will remove the custom ramp and revert back to 
the original default color ramp. 
 
 
3.8 Custom Label Files 
 
Each horizontal image may contain up to 10 labels that are used to describe data that are discrete or 
special data that stands out from the normal range of data, such as clear areas in an image of cloud 
top temperature. Normally, the text for the label, the colors used to plot the values, and the data 
range represented by the labels are read from the file. But there may be times when it is desirable to 
use a custom set of labels. This is done by creating a label file and placing it in the label_files 
directory. 
 
Within the data selection dialog is a drop-down list that contains all of the label files in the 
label_files directory. Any file in the directory can be applied to any horizontal image. When this is 
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done, the default label settings that are read from the source of the data are ignored and replaced 
with the label settings that are read from the chosen label file. 
 
Each label file is a text file containing a simple form of XML. A typical file my look like: 
 
 
<?xml version="1.0" standalone="yes" ?> 
 
<edgeis_labels> 
  <label_1> 
    <label_text>Sea</label_text> 
    <label_min>0.0</label_min> 
    <label_max>0.0</label_max> 
    <label_red>0</label_red> 
    <label_green>0</label_green> 
    <label_blue>255</label_blue> 
  </label_1> 
 
  <label_2> 
    <label_text>Land</label_text> 
    <label_min>1.0</label_min> 
    <label_max>1.0</label_max> 
    <label_red>0</label_red> 
    <label_green>255</label_green> 
    <label_blue>0</label_blue> 
  </label_2> 
 
  <label_3> 
    <label_text>Coast</label_text> 
    <label_min>2.0</label_min> 
    <label_max>2.0</label_max> 
    <label_red>255</label_red> 
    <label_green>0</label_green> 
    <label_blue>255</label_blue> 
  </label_3> 
 
  <label_4> 
    <label_text>Sleet</label_text> 
    <label_min>10.0</label_min> 
    <label_max>10.0</label_max> 
    <label_red>255</label_red> 
    <label_green>255</label_green> 
    <label_blue>0</label_blue> 
  </label_4> 
 
  <label_5> 
    <label_text>White Stuff</label_text> 
    <label_min>11.0</label_min> 
    <label_max>11.0</label_max> 
    <label_red>0</label_red> 
    <label_green>255</label_green> 
    <label_blue>255</label_blue> 
  </label_5> 
</edgeis_labels> 
 
Each label is named beginning with “label_1” and ending with “label_10”. It is not necessary to 
define settings for all 10 labels. For each label, the <label_text> tag contains the text used 
underneath the color scale to represent the label. The <label_min> and <label_max> tags contain the 
minimum and maximum data ranges for the label. All data values that fall between these two values 
will be mapped to the label color. The color used for the label is defined by the red/green/blue values 
in the corresponding tags. The values in these tags can range from 0 to 255. 
 
 
 
 
 

Custom Label Files 
 

The use of custom label files provides a significant amount of flexibility when creating horizontal images. But 
the fact that the label files are plain text files and can be modified by each user can potentially cause problems or 
confusion. The problems can be caused if the XML data in the file is not defined properly. The use of XML 
reduces this problem somewhat but does not eliminate it. The use of custom label files can cause confusion if the 
label settings, in particular the minimum and maximum range, are not set carefully. It is possible to get an image 
that is not what is expected even though the label settings are correct. While none of these problems are likely to 
result in a fatal error, each user is urged to use care when creating custom label files. 
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It is possible to force EDGEIS to ignore certain data values or data ranges. This is done by putting 
the string *ignore* within the <label_text> tag. If this is done, all data values within the minimum 
and maximum label range will be plotted in the background color and, therefore, will not show up in 
the image. 
 
An optional tag, <scale_type>0</scale_type> can be added to the XML file (either before or 
after the label tag groups). This tag can be used to force EDGEIS to used a particular type of scale 
with the image. Depending on the type of data being used to create an image, either a continuous 
color scale or a discrete color scale will be used. If the <scale_type> tag is not present or if it 
contains a value of 0, then the scale used will be determined by the data being plotted. If a value of 
the tag is 1 then a continuous scale will be used regardless of the type of data. A tag value of 2 will 
result in a discrete scale being used. 
 
The use of the <scale_type> tag will usually occur when plotting continuous data, such as 
temperatures, but when using a custom label file to sort the values into discrete data ranges. In such 
an example, the lack of a <scale_type> setting of 2 would result in a continuous scale being used 
with a set of special values attached. This would look awkward because the color scale would show 
a continuous range of colors on the left and the colors matching the custom labels on the right. By 
forcing the scale to be discrete, the continuous range of colors would not be displayed. 
 
 
3.9 Viewing Individual Profiles 
 
EDGEIS provides the ability to view individual profiles at any location that contains profile data. 
When a location is selected, the program will search the file for data that is closest in distance to the 
selected location. The necessary data is then read and a window will appear that contains a graph of 
every available profile in the file as well as other selected data. 
 
 
 

 
Figure 9 – Selecting Individual Profiles. 
 
After turning on the profile selection 
function, the cursor will turn into a hand  
with a profile graph on top of it. At this  
point, clicking anywhere on the horizontal 
image will result in the generation of a  
graph showing all available profiles from  
the data point that is closest to the selected 
location. 
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3.9.1 Selecting A Profile 
 
To view individual profiles, the profile function must be turned on by selecting “View Profile” under 
the Tools menu or by clicking on the view profile button in the toolbar. This will result in the cursor 
being changed to a profile cursor (Figure 9) when it is over a horizontal image that was generated 
from a file containing profile data. If the file from which the image was generated does not contain 
any profile data, the cursor will change to a red X. 
 
If the cursor is a profile cursor, then you can select a location by clicking on the image. The spot that 
the hand is pointing to will be the selected location. After the location is selected a window will 
appear. Depending on the location of the data and the size of the file, there may be a delay ranging 
from less than a second to several seconds or more while the program searches for the nearest 
retrieval and reads the appropriate data. If no retrievals were found near the selected location, a 
warning dialog will appear and the window will go away. It will then be necessary to select another 
location. 
 
If the current frame contains a single horizontal image, then the profile window will contain a single 
graph. If the frame contains more than one horizontal image the profile window will still contain a 
single graph. The data for the graph will come from the file that the image was created from. If there 
is more than one horizontal image in the current frame, it is possible to create graphs for each image 
in the frame. This is done by holding down the shift key while selecting a location in one of the 
images. If this is done, the profile window will contain graphs for each image in the frame using the 
same location for each one. 
 
 
 
3.9.2 The Individual Profile Window 
 
The profile window is a resizable window that contains a graph of the profiles along with selected 
data associated with the profiles being plotted. The graph area of the profile window contains all of 
the profiles that are available in the file. Seven different plot types can be used to display the 
profiles. Four of these plot types are XY plots while three are Skew-T Log-P plots. 
 
Below the graph is a small globe on which is indicated the approximate location of the data. Next to 
the globe is a legend that shows the color and style of the lines that represent each profile. As the 
mouse is moved over the graph, the data value of each profile that matches the pressure level is 
displayed next to the profile description. 
 
 
 
 
 

Searching For Matching Profiles 
 
It is not necessary to click directly on top of a data footprint when selecting a location. EDGEIS converts 
the x/y coordinate that was clicked on into latitude/longitude values. It will then search for data that is 
closest is distance to this latitude and longitude. The advantage of this is that selecting a location is easier 
since it is not necessary to be highly precise when clicking on the image. The disadvantage of this method is 
that it is possible that the profile you end up with may not be the one you wanted. This is especially true if 
there is a large amount of overlapping data. 
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Figure 10 – Individual Profile Window. 
The graph shows all profiles that were found for the data point at the selected location. 

The graph is customizable and can be changed between Skew-T Log-P and several 
varieties of a standard XY plot. The display of the data on the right may also be customized. 

 
 
The right-hand side of the window contains selected data associated with the data. Most of this 
information is presented in a table. Depending on the type of data presented, the value may or may 
not fit within the available space. If there is not enough space to display all of the data, then a 
scrollbar will appear on the side of the table. The width of each column in the table can be changed 
by moving the mouse pointer to the table header. When the cursor moves directly over the division 
between two columns, it will change. At this point it is possible to click and drag the column divider 
to either the left or right to change the width of the two columns. 
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3.9.3 Changing The Display Of The Profile Window 
 
The manner in which the data is displayed is very flexible. To change the display of the graph, either 
click the graph icon in the toolbar or select “Change Graph” from the Display menu. Both of these 
options will bring up a dialog (Figure 11) containing various display options. There will be one 
panel in the dialog for each panel in the main profile graph window. 
 
The top of the dialog shows the seven available plot types. Images of each plot show the 
approximate position along the pressure axis of selected pressures. The plot type is selected by 
clicking on the image of one of the plot types. When a new plot type is selected, the graph in the 
profile window will be updated automatically to show how the data looks given the new choice of 
plot type. 
 
 

 
Figure 11 – Changing The Display Of A Profile Graph 

The type of plot used to display individual profiles can be changed using this dialog. 
The five plots on the left are XY plots. The three on the right are SkewT LogP. 

In most cases, either the left plot type or right plot type will be used. 
The other types are included to provide greater flexibility if it is needed. 

 
 
The five plot types on the left of the dialog are standard XY plots. The P2/7 plot type plots the 
pressures raised to the 2/7 power. This results in a plot with 100 mb roughly centered vertically. The 
Linear option plots the pressures on a simple linear scale from 0.1 mb to 1000 mb. This plot type 
emphasizes the lower atmosphere while greatly de-emphasizing the upper atmosphere. The 
Logarithmic plot type displays the pressures on a log10 scale which emphasizes the upper atmosphere 
at the expense of the lower atmosphere. The Special 1 and Special 2 scales are modified linear 
scales. They both contain three separate linear scales: 0.1 mb to 100 mb, 100 mb to 500 mb, and 500 
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mb to 1000 mb. Special 1 places 100 mb 25 percent of the way from the top of the graph to the 
bottom while placing 500 mb at the center point of the scale. Special 2 places 100 mb at 33 percent 
of the way from the top to the bottom and 500 mb at 66 percent. Both of the scales were designed 
with the intention of finding a scale that showed both the upper and lower parts of the atmosphere 
without overemphasizing one or the other. 
 
The three plot types on the right side of the dialog are skew-temperature log-pressure scales. Each 
scale plots the profile data using standard skew-t log-p calculations. The difference between the 
three scales is the upper pressure level allowed. The 100 mb scale only plots the data up to 100 mb 
while the 10 mb scale only goes up to 10 mb. Any profile data above these levels are ignored. 
 
When a standard XY plot is being used, it is possible to display grid lines at each major pressure and 
data level. This is done by selecting the “Show Grid Lines” option under the Display menu. For all 
types of graphs, the “Show Data Points” menu item can be selected. This will result in circles being 
drawn showing the location of each point that makes up the profiles. When this option is turned off 
only the profile lines are displayed. 
 
Underneath the plot types in the dialog are two checkboxes: “Show Grid Lines” and “Show Data 
Points”. The grid line box turns the display of grid lines on and off (this option is disabled when a 
Skew-T Log-P plot is selected). The data point box turns the display of data points on or off. When 
this is selected, the graph will show the actual data points that we used to create the profiles. 
 
Beneath the checkboxes is a list that will contain one or more groups of auxiliary data. Depending on 
the source of data there may be several groups of data available. The data from the chosen group is 
displayed in the table to the right of the graph. 
 
At the bottom of the dialog are checkboxes representing each of the available profiles. The profiles 
that are selected will be displayed in the graph. 
 
The “Zoom In” and “Zoom Out” menu items and toolbar buttons control the amount of zooming 
within the profile graph. Every time one of these is selected, each graph will zoom in or out by a 
factor of 2. It is possible to zoom in on a graph up to three times. When the amount of zooming is 
greater than 1, scrollbars will appear on the right-hand side and bottom of the graph. These allow the 
graph to be moved around to focus on a particular area. Another way to move around when the 
graph is zoomed is to move the mouse over the graph and then click and drag the mouse. The image 
will pan in response to the dragging of the mouse. 
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3.10 Viewing Vertical Cross Sections 
 
Vertical cross-sections (slices) of the atmosphere can be created between any two points on the 
Earth’s surface. When a cross-section is created, the line representing the cross-section is divided 
into 100 points. The file is then searched to find data points that are closest to each of the 100 points 
along the line. Profile data is read from each of the nearby data points and then a graphical 
representation of the profile data is displayed. 
 
 
3.10.1 Selecting A Vertical Cross-Section 
 
To view vertical cross-sections, the slice function must first be turned on by selecting “View Slice” 
under the Tools menu or by clicking on the view slice button in the toolbar. Once this is done the 
cursor will change to a slice cursor when it is over a horizontal image that was generated from a file 
containing profile data. If the file from which the image was generated does not contain any profile 
data, the cursor will change to a red X. 
 
To draw the line at which the vertical cross-section should be made, click on the image at the start of 
the line and, while keeping the mouse button pressed, drag the mouse to the end point of the line. As 
this is done a rubber band line will appear on top of the image. The final position of this line will be 
the location of the slice. 
 

 
 
Figure 12 – Creating A Slice. 
 
Creating a vertical cross-section  
is done by drawing a line across  
a horizontal image at the location  
of interest. The values used to 
create the cross-section will come 
from the data points that are  
closest to the line. 
 
 
 
 
 
 
 
 

 
 
If the current frame contains more than one image, then a cross-section will only be created for the 
image that the line was drawn on top of. However, if the shift key is held down while the line is 
being drawn, then the vertical cross-section window will contain a cross-section corresponding to 
each image in the frame. Each cross-section will be created using the same line. 
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3.10.2 The Vertical Cross-Section Window 
 
The vertical cross-section window shows an image of the Earth’s atmosphere (Figure 13). The Y 
axis of the image corresponds to pressure levels. The X axis of the image matches up with the 100 
points along the line. The image may also contain white and brown lines depending on the location 
of the slice. The white line shows cloud top pressures, if present and available. The brown line 
shows the pressure at the surface of the Earth, resulting in an approximation of the surface elevation. 
Any data below the surface is not displayed. 
 
 
 

 
Figure 13 – Vertical Cross-Section Window. 

The image on the left shows the cross-section of the atmosphere along the selected line. 
The right side of the window contains information about the data and a map showing 
the location of the cross-section. The arrow shows the direction that the cross-section 

is being viewed from. 
 
 
 
To the right of the cross-section is information about the vertical slice. The type of data used to 
create the slice is displayed along with the number of pressure levels used. The starting and ending 
times of the actual data are displayed along with the endpoints of the line. 
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Also to the right of the slice image is a small map that shows where the cross-section is located. The 
gray line across the map shows the area of the cross-section. The arrow shows the direction that the 
cross-section is being viewed from. When the slice line is drawn, the start of the line will be on the 
left of the slice while the endpoint of the line will be on the right side of the slice. 
 
 
3.10.3 Changing The Display Of The Vertical Cross-Section Window 
 
When a vertical cross-section is displayed for the first time the resulting slice image will usually 
show unsmoothed temperature data. The type of data displayed and the manner in which it is 
displayed can be changed by selecting the “Change Panel Options” menu item which is located 
under the Options menu. This will bring up a dialog that will allow the settings to be changed 
(Figure 14). 
 
 

  
Figure 14 – Changing The Slice. 

 
The vertical cross-section contains data for 
each available profile. The profile data being 
displayed is changed by selecting a new 
profile from the top list. 

 
Smoothing and contouring can also be applied 
in the same manner that they can be applied 
to a horizontal image. The color scale, data 
range and pressure limits are also adjustable. 

 
If the data source contains values for cloud 
top pressures, the display of these can be 
turned on or off by selecting or deselecting the 
box. 

 
 
 
 
 
 
The first item in the dialog contains a list of every profile that is available in the file. The type of 
data can be changed by selecting a different profile in this list. 
 
The image can be smoothed by changing the setting in the smoothing list. The smoothing is done 
using area averaging, so the larger the selected value the more the image will be smoothed. 
 
An image will typically contain 240 different colors. The number of colors can be reduced by 
changing the value in the contour field. This will result in a contoured image similar to the one 
shown in figure 13. 
 
The color scale defaults to a standard rainbow (purple to blue to green to yellow to orange to red) 
scale. This can be changed to black and white scales that either go from black to white or from white 
to black. 
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The minimum and maximum data values of the selected profile are listed in the minimum and 
maximum fields. If these values are changed, then the range of the color scale will be adjusted 
accordingly. 
 
After the data value fields are two drop-down lists that represent the minimum and maximum 
pressure levels. The selected minimum pressure will be the pressure that is displayed at the top of the 
slice image. The selected maximum pressure will be the pressure that is displayed at the bottom of 
the slice image. These options can be used to restrict the display of the slice in order to remove 
pressure levels at the top or bottom of the image. 
 
If either pressure level is set to a value that is not available in the data, then the largest or smallest 
pressure from the data will be used as the limit. For example, if the data only goes up to 200 mb 
(such as water vapor) and the minimum pressure is set to 10 mb, then the minimum setting will be 
ignored and the 200 mb data will be displayed at the top of the slice. 
 
The last option in the dialog will turn the display of the cloud top pressures, if available, either on or 
off. When cloud top pressures are displayed, white lines will appear on top of the slice image 
showing the locations of cloud tops. 
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4.0 Additional Features 
 
EDGEIS contains a variety of features that apply to the entire program. Some of these features 
provide useful functionality such as printing and saving images. Others exist in order to provide 
some flexibility in the display of data and in the manner in which the program runs. 
 
 
4.1 Printing 
 
EDGEIS provides the ability to print any image. This includes horizontal images, vertical cross-
sections and individual profile graphs. These images can be printed to any printer that the computer 
has access to. 
 
The orientation of the page can be changed between landscape and portrait using the page setup 
option. This is accessed by selecting “Page Setup” under the File menu and will bring up a dialog 
that allows you change the orientation of the page. Depending on the operating system being used, 
this dialog may also allow you to select a printer, change the page margins, change the paper size, 
and scale the image. 
 
A preview of the printed image can be viewed by selecting “Print Preview” under the File menu. A 
window will be created that shows what the printed image should look like. 
 
The actual printing of an image is done by selecting “Print” from the File menu. This will bring up a 
print dialog that allows you to make final changes to the settings before printing the image. Some 
operating systems provide the ability to print the images as a PDF file. If this option is available, 
there will be a button at the bottom of the print dialog (Figure 15) that saves the image as a PDF. 
Clicking this button will result in a save file dialog prompting you to name the file. 
 
 

 
Figure 15 – Print Dialog. 

This image shows a typical print dialog. The actual dialog will vary depending  
on the operating system being used. 
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4.2 Saving Images 
 
All horizontal images, vertical cross-sections and individual profile graphs can be saved as an image 
file (currently in jpeg format only). This is done by selecting “Save As Image” from the File menu. 
A dialog will appear (Figure 16) that lets you choose the size of the image. 
 
 

 
Figure 16 – Image Size Dialog. 
 
Images can be saved at any size. The current 
button will set the image size to the size of the 
image on the screen. The other buttons can be 
used to quickly select common sizes. Any  
other size can be used by changing the values  
in the text fields. 
 
If the “Preserve Aspect Ratio” box is selected, 
then the resulting image will use the same 
width to height ratio as the image has on the 
screen. 
 

 
 
The initial size of the image will be the same size as the image on the computer screen. The size can 
be changed by selecting one of the pre-defined size buttons or by entering new values in the “New 
Size” fields. If “Preserve Aspect Ratio” is selected, then the size of the image will be automatically 
adjusted to force it to have the same aspect ratio (width divided by height) as the current image. 
 
There are no limits to the size of the resulting image. Please be advised, however, that large size 
values (typically larger than 2000 x 1000) will result in very large images. It is also possible to enter 
very small values. But this could result in an image with text that is difficult to read or garbled. 
EDGEIS tries to fit all information into the available space. But if the amount of available space 
becomes too small then nothing can be done to make everything fit and be legible at the same time. 
 
After the size of the image is selected, a save file dialog will appear. After the location and name of 
the file is entered, the image is saved. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selecting Image Sizes 
 
The ability to change the size of saved images was added because it is often desirable to create an image 
that is a specific size. This often happens when creating images for use in presentations or papers. While 
it is possible to create an image at a default size and then resize the image at a later time, this usually 
produces images that are pixilated or missing data. It is usually a better idea to create an image at the 
necessary size from within EDGEIS. The text and thin lines within the image will almost always look 
better. 
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4.3 Setting Preferences 
 
Various preference settings can be changed by selecting “Preferences” under the Edit menu. This 
will bring up the preference dialog (Figure 17). Different types of preferences can be selected by 
clicking one of the icons along the left side of the dialog. When one of the icons is selected, the 
options on the right side of the dialog will change. 
 
The “Data Labels” preferences affect the display of certain labels used throughout EDGEIS. Most 
temperature values can be displayed as Kelvin, Celsius or Fahrenheit. The unit used can be changed 
by selecting one of the options in the dialog. Similarly, pressure values can be displayed as mb or 
hpa by changing the options in the dialog. Finally, the formats of dates can be adjusted by picking 
one of the available options. 
 

 
 
Figure 17 – Data Label Prefs. 
 
The buttons on the left side of the 
dialog can be clicked to changed 
between the available preference 
panels. 
 
The data label preferences affect 
the manner in which certain data 
labels are displayed. 
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The “Appearance” preference option (Figure 18) affects the look and feel of the windows and 
controls of EDGEIS. Although this feature is generally cosmetic, there may be times when adjusting 
the look and feel may improve the layout of windows and controls. There will usually be three 
options available. The Metal look and feel is a generic cross-platform setting. Selecting CDE/Motif 
will create windows that appear similar to those used by XWindows. The third option will usually be 
the same look and feel as the operating system that EDGEIS is being run on. 
 

 
 
Figure 18 – 
Appearance Prefs. 
 
The appearance 
preferences affect 
the overall look and 
feel of the program 
windows and 
controls. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Changing Font Sizes 
 
When the area available for the text is large, the minimum font size setting does not matter. When the 
available space is small, however, this value will make a difference. When there is little room available to fit 
the text, the program will shrink the text as much as possible to try to make it fit. If the minimum font size is 
set too low, then the text may be too small to read. But if the value is set too high, then there may not be 
enough room and the text will be drawn using the set value resulting in text that may overlap or not fit 
within the window. The extent to which this is a problem depends on the operating system, computer 
monitor, and the resolution of the computer screen. If you experience problems with some of the text, then 
adjusting the font settings may help. 
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The “Fonts” preference panel (Figure 19) provides the ability to change the font, font style, and 
minimum font size of some of the labels used by EDGEIS. A list of every font that is available on 
the computer is provided from which a desired font can be picked. The style of the font can also be 
selected. The minimum font size is the smallest size that will be used when drawing labels. When 
drawing labels, EDGEIS will try to use as large a font size as possible while still allowing all of the 
text to fit. But the program will stop reducing the font size when it reaches the value set here. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 19 – Font Preferences. 
The font, font style and minimum font size can be adjusted by changing these controls. 

The list of fonts will contain every font available on the computer. 
 
 
 
The “Data Servers” preference option (Figure 20) can be used to change the list of available data 
servers from which data can be obtained. EDGEIS starts with a default set of servers but it may be 
desirable to add new servers to the list or to prevent access to a server. Although it is possible to add 
the address of any computer to the list of servers, only computers running a valid data server will be 
usable.  
 
The preference panel contains a table of data servers. The first column contains a checkbox. If the 
box is selected the data server in the row will be added to the list of servers. If the box is not selected 
the server will be skipped. The second column contains a descriptive name for the data server. The 
third column contains the IP address of the server while the fourth column contains the port number. 
 
 



 40 

 
 

 
 

Figure 20 – Data Server Preferences. 
EDGEIS will contact all servers in the list that have the “Use Server” box checked. 

The “Allow Network Connection” box allows or prevents connection to any of the servers. 
 
 
The preference panel also contains the checkbox “Allow Network Connection”. When this box is 
selected EDGEIS will contact the selected data servers. When the box is not selected, the data 
servers will not be contacted and it will not be possible to generate images using data from the data 
servers. This may be useful when EDGEIS is being run from a computer that does not have a 
dedicated Internet connection. When the network connection is not selected, EDGEIS will not 
attempt to establish an Internet connection in order to obtain initial information from the data 
servers. 
 
The “Profiles” preference option (Figure 21) can be used to change the color, thickness and style of 
lines used to represent profiles in the profile graph windows. The preference panel contains selection 
options for 16 profiles. When profiles are displayed in the profile graph, they are displayed in a 
certain order that may vary depending on the source of the data. But in general, the order that they 
are listed in the legend of the profile window will be the order that they are listed in the preference 
panel. For example, most of the time the profiles will be listed in the order: retrieved temperature, 
retrieved dew point, first guess temperature and first guess dew point. This should match the order in 
the preference panel. 
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Figure 21 – Profile Style Preferences. 
EDGEIS will contact all servers in the list that have the “Use Server” box checked. 

The “Allow Network Connection” box allows or prevents connection to any of the servers. 
 
 
For each profile, it is possible to change the color, line thickness and line style. This is done by 
changing the selection in each of the 3 columns of drop-down lists. This color list show a set of pre-
defined colors. This thickness list allows the thickness of each line to be adjusted from 1 pixel (thin) 
up to 9 pixels (thick). The style of the line can be set to either solid or dashed. When any of the 
options are selected, the profiles in any open profile windows will be immediately updated. This 
provides quick feedback when deciding which options to use. 
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4.4 Changing Labels In An Image 
 
When horizontal images are created the title labels are created from data in the file. The labels and 
be changed by selecting “Change Labels” under the Tools menu. This will bring up a dialog that 
allows the labels to be changed (Figure 22) 
 
 

 
 

Figure 22 – Title Label Dialog. 
Each image can contain up to 9 title labels. Each label can be changed by 

entering new values in the text fields in this dialog. 
 
 
 
Each image has room for as many as nine labels (3 rows and 3 columns). Each grid in the dialog 
represents one of the labels. If a grid does not contain any text then the label will be not displayed. 
The length of each label is unlimited. However, they should be kept reasonably short. EDGEIS will 
try to arrange the labels to make each one fit, but if the labels are too long then this will not be 
possible and the labels will overlap or not fall within the available area. 
 
 
4.5 Using The Shortcut Accessory 
 
All file dialogs used by EDGEIS include a shortcut accessory. This is an addition to the dialog that 
allows frequently used files and directories to be accessed quickly. The list of files and directories is 
customizable. 
 
The actual location and look of the shortcut accessory will vary depending on the operating system 
but will look similar to figure 23. The file dialog will contain all of the controls that a normal file 
dialog contains. 
 
Files and directories are added to the list of shortcuts by selecting one in the file list and then 
clicking the add button. This will add the file or directory to the end of the shortcut list using its fully 
qualified name. The shortcut can be removed by highlighting it in the shortcut list and clicking the 
delete button. 
 
The shortcut accessory also provides the ability to use an alias for any shortcut or directory. When an 
alias is used, it will appear in the shortcut list in place of the full file or directory name. To 
distinguish aliases from regular file names, all aliases appear in the shortcut list surrounded by 
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brackets. An alias is assigned by highlighting the shortcut in the shortcut list, then typing the alias 
name in the text field next to the set button. Once the set button is clicked, the alias will be assigned. 
 
Another feature provided by the shortcut accessory is the use of color to differentiate shortcuts. The 
color used by a shortcut is set by adding “color#” in front of the alias name. For example, setting the 
alias as “blue#Test File” will create an alias called “Test File” that will be displayed in blue. The 
color can be removed by retyping the alias name without a color in front of it. The possible colors 
are: blue, red, yellow, green, orange, cyan, magenta, pink, and teal. 
 
Other colors can also be used by typing a 6 digit hexadecimal string in front of the alias. The first 
two digits represent the red component of the color, the next two digits represent the green, while the 
last two represent the blue. For example, setting the alias as “FF8000:Test File” will result in an alias 
that is displayed using orange (red=255, green=128, blue = 0). Although this method is a little more 
difficult to use, it does provide for the use of nearly all colors. 
 
 
 

 
 

Figure 23 – File Open Dialog With The Shortcut Accessory. 
File dialogs in EDGEIS contain a shortcut accessory, which is an additional control located next to the list of files. 
The shortcut accessory contains a list of shortcuts to frequently used files or directories. This allows for files and 
directories to be accessed quickly without the need to traverse the computer’s directory structure. The shortcuts 

in the list can be added and removed at any time. The shortcut accessory also displays information about the 
selected file. 
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5.0 EDGEIS And POSSE Files 
 
Beginning with EDGEIS 6.0 a new file format is used. This format is similar to the format used by 
previous versions of EDGEIS in that the parameters are grouped into blocks of data. The file 
contains a header that describes the data in the file. The header is then followed by multiple blocks 
of data, each of which contains data for one parameter. 
 
The new format differs from the old format in the following significant ways: 

• The new files do not have to be byte-swapped in order to make them work on PCs. 
• The data in the old files were grouped in blocks of 256 bytes each. There would be a 256 

byte block for the first parameter, then a 256 byte block for the second parameter, an so on. 
After the 256 byte block for the last parameter, there would be another 256 byte block for 
each parameter. With the new format, the data for each parameter is stored in one large 
block. The size of each block varies depending on the amount of data available. 

• The old format required separate files for sequential and gridded data .The new format still 
requires separate files for sequential and gridded data, although beginning with EDGEIS 6.0 
it is possible to display sequential data in a gridded format. Depending on the application this 
may eliminate the need to create a sequential file and a gridded file, both of which contain 
the same data. 

• Using the old format, it was necessary to create separate files for data that used the Cartesian 
projection and data that used the Polar projection. Beginning with EDGEIS 6.0, there is no 
longer a need to create separate files for each projection. The data are stored along with 
corresponding latitudes and longitudes. These are used to display the data in any of the 
available projections. This applies to both sequential and gridded data. 

• The new format contains special data indicators for selected parameters. These are used to 
determine what type of data the parameter represents. 

• The old file format restricted the number of parameters in each file. With the new format, the 
number of parameters is unlimited. 

 
A typical file using the new format may be arranged as follows: 
 

Header record 
Latitude Data Block 
Longitude Data Block 
Year (YYYY) Data Block 
Month and Day (MMDD) Data Block 
Hour (HH) Data Block 
Minute and Second (MMSS) Data Block 
1st Parameter Data Block 
2nd Parameter Data Block 
. 
. 
. 
Nth Parameter Data Block 

 
 
In the file, the data blocks follow the header record. The order of the data blocks is not important. 
Although it is customary to have the header record followed by the block of latitude data, followed 
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by the block of longitudes, followed by the date and time data blocks, followed by the parameters, it 
is not mandatory to order the blocks in this way. The use of data indicators allows the blocks to be 
arranged in any order. One thing to note, however, is that the order of the parameters affects the 
order in which the available parameters appear within the data selection dialog of EDGEIS. The 
order of the parameters in the file is the order in which they will appear in the selection dialog. 
 
For sequential data, each file must contain a block of latitude data and a block of longitude data. 
These are mandatory since the latitude and longitudes will be matched with data from the parameter 
that is being displayed. If the latitudes and longitudes are not present, or if they do not match with 
the other data in the file, then the resulting image will be incorrect. For latitudes, the data indicator in 
the block header should be set to 20000. For longitudes it should be set to 20001. When looking for 
these data, EDGEIS will search for those indicators. 
 
Each file may also contain blocks of data for a 4-digit year (data indicator = 20002), month and day 
(mmdd, indicator = 20003), hour (indicator = 20004), minute and second (mmss, indicator = 20005), 
and orbital node (indicator = 20006). These parameters are not mandatory but can be used to restrict 
the data that is displayed. For example, the file may contain data from 0Z to 23Z but if the dates and 
times are available, EDGEIS can be told to only display data from 6Z to 18Z. 
 
One of the most significant features that was introduced with EDGEIS 6.0 is the ability to display 
individual sounding profiles and vertical cross-sections. These features would not be possible if it 
were not for data indicators to tell EDGEIS which data blocks contain profile data. For profile data, 
such as temperatures and water vapor, there is a range of data indicators that are reserved to allow 
the data to be grouped into separate profiles. All temperatures profiles use data indicators that range 
from 10000 to 10499. Water vapor profiles range from 10500 to 10999. Although the specific data 
indicator for a group of profile data does not matter in general, it is suggested that certain indicators 
be used with certain data. For example, retrieved temperature data should use 10000 while first 
guess temperature data should use 10001. All blocks that contain data for the same profile should 
use the same data indicator. This tells EDGEIS that the separate blocks contain data for the same 
profile. With profile data it is important that a pressure level be supplied in the data block header. 
Without this value, EDGEIS will not know where the data fits into the profile and will not be able to 
plot it. 
 
One of the primary benefits of the new format is that it is also used by POSSE. This reduces the 
amount of overhead required to create the files since the same data capture programs can be used to 
capture data for both programs. 
 
The numerical data are stored in the header record as either 2-byte or 4-byte integers. Floating point 
values are multiplied by the scaling factor before being written to the file. Character strings are 
stored as a series of ASCII byte values. 
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Appendix A — Edge / POSSE File Format 
 
Note: Unlike EDGEIS 5.x files, EDGEIS 6.x files do not need to be byte swapped regardless of  

the platform on which EDGEIS is running. 
 
 
Header Record 
 
Byte Word Data 

Type 
# of 

Values 
Length Scale Description 

0 1 Int 1 4  File type  
(69687169 = “EDGE”) 

4 2 Float 1 4 10 File version number 
(i.e., “10” = 1.0) 

8 3 Int 1 4  Data type 
(0=sequential, 1=gridded) 

12 4 Int 1 4  Length of header record (bytes) 
16 5 Int 1 4  Number of data blocks 
20 6 Int 1 4  Length of each data block 
24 7 Int 1 4  Number of values in each block 
28 8 Int 1 4  File initialization date 

(YYYYMMDD) 
32 9 Int 1 4  Date of last file update 

(YYYYMMDD) 
36 10 Int 1 4  Date of oldest data in the file 

(YYYYMMDD) 
40 11 Int 1 4  Time of oldest data in the file 

(HHMMSS) 
44 12 Int 1 4  Date of newest data in the file 

(YYYYMMDD) 
48 13 Int 1 4  Time of newest data in the file 

(HHMMSS) 
52 14 Float 1 4 100 Left longitude (-180 to +180) 
56 15 Float 1 4 100 Right longitude (-180 to +180) 
60 16 Float 1 4 100 Top latitude (-90 to +90) 
64 17 Float 1 4 100 Bottom latitude (-90 to +90) 
68 18 Float 1 4  Index of last data written 
72 19 Float 1 4 10 Horizontal grid size in degrees 

(if data is gridded) 
76 20 Float 1 4 10 Vertical grid size in degrees 

(if data is gridded) 
80 21 Char 1 36  System description 

(“ATOVS NOAA-16 (A2)”) 
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Data Record 
 
Byte Word Data 

Type 
# of 

Values 
Length Scale Description 

0 1 Char 1 36  Parameter description 
36 18 Int 1 2  Parameter number1 
38 19 Int 1 2  Visibility flag 

(0=don’t show, 1=show) 
40 20 Float 1 2 10 Spot size in km 

(if data is sequential) 
42 21 Int 1 2  Scaling factor 
44 22 Float 1 4 100 Default minimum 
48 24 Float 1 4 100 Default maximum 
52 26 Float 1 4 100 Center point 
56 28 Float 1 2 10 Pressure (if applicable) 
58 29 Int 1 2  Alternate label flag (0=none, 1=temperature, 

2=pressure) 
60 30 Char 1 12  Unit 
72 36 Int 1 2  Data type (0=continuous, 1=not continuous) 
74 37 Float 10 4 100 Special values 

(-32768 if not used) 
114 57 Char 10 12  Special descriptions 
234 117 Int 1 2  Scale number2 
236 118 Int 256 2  Color scale (red values) 
748 374 Int 256 2  Color scale (green values) 
1260 630 Int 256 2  Color scale (blue values) 
1772 886 Int 1 2  Offset within master file 

(used by POSSE only) 
1774 887 Int 13 2  Spare 
1800 900 Float num vals 2  Data 
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Appendix B — EDGEIS 5.x File Format 
 
EDGEIS 5.x files can contain data in either gridded or sequential format. The layouts of the file for 
gridded and  sequential data are: 

 
 
 
 
 
Note: All EDGEIS 5.x files contain swapped bytes to make the least significant byte first.  

EDGEIS 6.x automatically compensates for this regardless of the platform on which  
it is running. 
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Header Record 
 
Byte Word Data 

Type 
# of 

Values 
Length Scale Description 

0 0 Int 1 2  Grid type (1=cartesian, 2=polar) 

2 1 Int 1 2  Data type index1 

4 2 Int 1 2  Starting year 

6 3 Int 1 2  Starting month 

8 4 Int 1 2  Starting day 

10 5 Int 1 2  Starting hour 

12 6 Int 1 2  Ending year 

14 7 Int 1 2  Ending month 

16 8 Int 1 2  Ending day 

18 9 Int 1 2  Ending hour 

20 10 Int 1 2  Number of parameters in the file 

22 11 Int 1 2 100 Version number of the file header format 

24 12 Int 4 2  Signature: “EDGEGrid” 

32 16 Int 1 2  Number of words per row 

34 17 Int 1 2  Number of rows in the grid2 

36 18 Int 1 2 100 Maximum latitude of the grid (-90 to +90) 

38 19 Int 1 2 100 Maximum longitude of the grid (-180 to +180) 

40 20 Int 1 2 100 Minimum latitude of the grid (-90 to +90) 

42 21 Int 1 2 100 Minimum longitude of the grid (-180 to +180) 

44 22 Int 1 2 1000 Increment between grid points (latitude) 

46 23 Int 1 2 1000 Increment between grid points (longitude) 

48 24 Int 1 2  Y coordinate or row number of Pole (polar only) 

50 25 Int 1 2  X coordinate of column number of Pole (polar only) 

52 26 Int 1 2 100 Column spacing at standard latitude (polar only) 

54 27 Int 1 2 100 Longitude parallel to columns (polar only) 

56 28 Int 27 2  File description (up to 54 characters) 3 

110 55 Int 27 2  Satellite system description (up to 54 characters) 4 

164 82 Int 46 2  Spare 

 
 
1 The data type index is used to indicate what type of data the file contains. It is compared to the 
value in the external table which defines the list of available data types. The primary use for this 
variable is to make sure that only files which are compatible with the selected data type will be used. 
For example: If the datatype.prm file contains the value 3 for the data type index, only data files that 
have a 3 in this word will be considered valid files. The special value 99 can be used in the 
datatype.prm file to indicate that any data file is to be considered valid. 
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2 Polar files will actually have twice as many rows because there is a grid for the north and another 
grid for the south. 
 
3 The file description is stored as a sequence of ASCII values. This value is not used by EDGEIS 6.x. 
 
4 The satellite system description is stored as a sequence of ASCII values. This value is displayed in 
the title panel of each EDGEIS image. 
 
 
Data Block Header 
 
Byte Word Data  

Type 
# of  

Values 
Length Scale Description 

0 0 Int 1 2  Parameter number 

2 1 Int 1 2  Scaling factor 

 2 Int 1 2  Description flag 

6 3 Int 1 2  Data parameter description 

8 4 Int 1 2  Default map color pen number 

10 5 Int 1 2  Default scaling method 

12 6 Int 1 2  Default minimum to use for scaling data 

14 7 Int 1 2  Default maximum to use for scaling data 

16 8 Int 1 2  True minimum value contained in the grid 

18 9 Int 1 2  Log minimum value contained in the grid 

20 10 Int 1 2  True maximum value contained in the grid 

22 11 Int 1 2  Switch for missing data fill value 

24 12 Int 4 2  Missing data fill value 

32 16 Int 1 2  Switch for auxiliary fill value 

34 17 Int 1 2  Auxiliary fill value 

36 18 Int 1 2  Color lookup table index 

38 19 Int 1 2  Label file name 

40 20 Int 1 2  Scale type 

42 21 Int 1 2  Center value 

44 22 Int 1 2 100 Radius of spot size (degrees) 

164 82 Int 46 2  Spare 

 
 
 





 53 

Appendix C — Pre-Defined Data Indicators 
 
5001 Forecast Time Difference 
5002 Forecast Increment 
5003 Forecast Year 
5004 Forecast Month/Day 
 
10000 Retrieved Temperature 
10001 First Guess Temperature 
10002 AVN Forecast Temperature 
10003 AVN Analysis Temperature 
10010 AMSU-A Brightness Temperature (not limb corrected) 
10011 AMSU-A Brightness Temperature (limb corrected) 
10012 HIRS Brightness Temperature (not limb corrected) 
10013 HIRS Brightness Temperature (limb corrected) 
10049 Generic Temperature Profile 
 
10500 Retrieved Water Vapor 
10501 First Guess Water Vapor 
10502 AVN Forecast Water Vapor 
10503 AVN Analysis Water Vapor 
10999 Generic Water Vapor Profile 
 
20000 Latitude 
20001 Longitude 
20002 Year (yyyy) 
20003 Month/Day (mmdd) 
20004 Hour (hh) 
20005 Minute/Second (mmss) 
20006 Orbital Node 
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Appendix D — Pre-Defined Color Ramps 
 
 

Ramp 
Number 

 
Ramp Appearance 

 
 

 
0 

 Use the scale provided in the data 
block header 

 
1 

 
 

 
Rainbow 

 
2 

 
 

 
Cloud (white to blue) 

 
3 

 
 

 
American 

 
4 

 
 

 
Precipitation 

 
5 

 
 

 
10 Color 

 
6 

 
 

 
Terrain 

 
7 

 
 

 
Cloud Mask 

 
8 

 
 

 
Grayscale (white to black) 

 
9 

 
 

 
Grayscale (black to white) 

 
10 

 
 

 
Cloud (blue to white) 
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Appendix E — Map Projections 
 
 
 
Cartesian 

 
The Cartesian projection is the default 
projection used by EDGEIS. The 
longitude of the center of the map is set 
to 0 degrees by default. This can be 
changed by setting the value of the 
center longitude to another longitude. 
 
 
 
 

 
 
 
Polar 

 
The Polar projection displays either the 
northern hemisphere or the southern 
hemisphere. When this projection is 
chosen, it is possible to set the value of 
the latitude extent, which limits the 
amount of the hemisphere that is 
showing. For example, if the latitude 
extent is set to 30 degrees, then the 
resulting map will show the hemisphere 
from the pole to 30 degrees. 
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Dual Polar 
 
The Dual Polar projection is similar to 
the Polar projection. The difference is 
that this projection shows both 
hemispheres at the same time. As with 
the Polar projection, the latitude extent 
can be used to limit the amount of the 
hemisphere that is visible. 
 
 
 
 
 
 
 
 

 
 
Orthographic 

 
The Orthographic projection simulates a 
point-of-view perspective. Using this 
projection is like looking at a globe 
above any point. The center latitude and 
longitude values are used to select the 
spot on the Earth that the image should 
be centered on. 
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Mollweide 
 
The Mollweide projection shows an 
elongated view of the Earth. By default, 
the image is centered at 0 degrees 
longitude, but this can be changed by 
setting the center longitude to another 
value. 
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Appendix F — EDGEIS Versions 
 
Version 6.4 
 

• The file separator was changed from a platform specific character to a Java neutral character. 
 

• The main window toolbar has been moved from the top of the window to the left side of the 
window. This should provide more vertical space for the images. 

 
• The color scale has been changed to display better precision when dealing with very small 

numbers. Also, the display provides better feedback when the image does not contain any 
data. The ColorScalePanel class has also been changed to combine code for the two types of 
scale into single code. 

 
• In the LayersPanel, the auto adjust thickness boxes have been removed. This feature has not 

yet been implemented. 
 

• The layout of the controls in the LayersPanel has been changed to allow the controls to fit 
better within the available space. This should solve the problem where the DataChoiceDialog 
does not fit on the screen. 

 
• The OK button in the MathFunctionDialog has been set as the default button. 

 
• Added a masking feature which will display selected values using a mask color. 

 
• Fixed a small problem in the blinking data selection dialog where the size of the 

BlinkRangePanel did not allow all of the controls to be visible. 
 

• At the request of users, the long variable descriptions in the MathFunctionDialog have been 
replaced with shorter names of the form “Frame N – panel M”. 

 
• The automatic setting for layer 3 (geo-political data) is now working. 

 
• The default grid line color used to default to the background color. It has been changed to use 

the foreground color as the default. When using the background color, the grid lines would 
appear to be missing when they were actually present. 

 
• The background colors for the ProfileChoiceDialog and SliceChoiceDialog have been 

changed from gray to the default color. 
 

• A bug was fixed which sometimes affected the sorted of pressure levels for slice data. 
 

• The indefinite progress indicator was added to the slice and profile panels. This replaces the 
simple string that had been used. 

 
• A bug in the code that creates a copy of a frame has been fixed. The bug caused the original 

frame and the copy of the frame to point to the same temporary file. As a result, when one of 
the frames was changed, the other frame would also be changed. 
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• The list containing descriptions for all open data frames has been adjusted to add the frame 

number before the frame description. This should prevent confusion that can be caused when 
different frames use the same description. It also eliminates a strange bug that sometimes 
occurs when two or more items within a drop-down list have the same string. 

 
• A feature was added which opens all frame files that are located within a chosen directory. 

This should make it easier to add a large number of frames in one shot. 
 
 
Version 6.3 
 

• In the preference dialog, custom JToggleButtons have been replaced with a JTabbedPane. 
 

• The default value for the preference setting allow_network_connection has been changed 
from true to false. 

 
• The ability to pick parameters based on the parameter number within the file has been added. 

This was done primarily for ImageMaker but it affects ImageInformation. The variable 
word_number in ImageInformation was replaced with parameter_type. This allowed for the 
addition of parameter number without changing the number of variables stored. It also 
simplifies the code somewhat. 

 
• ErrorHandler was updated to make it handle cases where the program that calls it is running 

in a headless environment. Previously, such cases would result in a HeadlessException when 
the error dialog was displayed. ErrorHandler now catches such an exception and ignores it. 
Also, the entire stack trace of the exception is printed out. 

 
• The ability to plot grid line numbers has been added. 

 
• The bug that prevented the Earth outline from being shown was fixed (the IndexColorModel 

was using 255 colors instead of 256). 
 

• In the dual polar projection, the southern hemisphere was flipped to make it line up with the 
northern hemisphere when they are plotted side by side. 

 
• In ImageRenderer, code was moved from addDataToSequentialImage() into the initialization 

method. This improves the efficiency of the image rendering since the code, which sets the 
radius of the ovals of at each latitude, is now done once instead of multiple times. 

 
• An animated progress indicator was added to EdgeImage in order to provide visual feedback 

to the user while new images are being created. 
 

• A method was added to ProfileParameterPanel to make it automatically adjust the size of 
each column in the parameter table. The columns are now sized to try to make room for all of 
the table contents. The new method replaces an older method that never worked well. 
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• An option was added to display a window that shows all of the output and error messages 
produced during the run of the program. 

 
• A new feature was added that causes a new image to be created when the F6 key is pressed. 

The new image will contain the next parameter in the file. This makes it easier to loop 
through the parameters in the file since it is not necessary to bring up the data selection 
dialog every time. 

 
• A new preference option was added that allows invisible parameters to be displayed in the 

list of available parameters in the select data dialog. 
 
 
Version 6.2 
 

• When raw data is displayed to the right of the profile graph, water vapor maxing ratios were 
plotted incorrectly. They were scaled by 1024 but e to that power was not done. The scaling 
was changed to correct the values. 

 
• Added the “Copy Frame To” feature at the request of some users. This new feature will 

replace an available frame with a copy of the current frame. 
 

• Major changes were made to the program. The first thing changed is the renaming of 
FrameManager to EdgeWindow. Much of the interface code was moved from Edgeis to the 
new EdgeWindow. Code was added to Edgeis to handle multiple instances of EdgeWindow 
and the saving and opening of EdgeWindow files. 

 
• Another big change is the complete reworking of the persistence scheme. Previous versions 

used Java’s externalization scheme. But this cause problems between versions of Java. The 
new scheme still uses externalization but it does it in a way that doesn’t save the JPanel 
properties of EdgeFrame, EdgePanel and EdgeImage. At the same time, the state of the 
program is now divided into two files. The preferences are saved in a new file while the 
EdgeWindow values are saved with the EdgeWindow files. 

 
• Globals variables are now stored in EdgeisGlobals and ProfileGlobals. They were stored in 

EdgeisGlobals and EdgeGlobals. 
 

• The next big change was the restructuring of the math functions. MathReader is now gone. 
The functionality of it was moved into ImageReader. ImageReader calls the appropriate data 
reader when a simple image is requested. But when a math image is requested, ImageReader 
processes the math function. This accomplishes two things. First, it allows for recursive math 
functions. It also enhances the math capabilities by handling equations that exceed addition, 
subtraction, multiplication and division. The open source code JEP (Java Expression Parser) 
was obtained and is now included with the rest of the code. JEP parses a math equation and 
calculates the result. 

 
• Changes to the thickness of a profile line worked correctly when the profile graph was 

displaying an XY graph, but not when a SkewT graph was being displayed. This has been 
fixed. 
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• The NewFrameDialog has been changed to allow for up to 3 columns and rows (3x3). 

 
• The ability to set a specific time window has been added to the DataChoicePanel. Two 

JComboBoxes are being used for now. Eventually, it would be nice if these could be replaced 
with a double slider to allow the user to select the range of dates more easily. 

 
• The DataChoicePanel was modified to include a text field for zooming value. Also, a 

LatLonDialog has been added to provide the user with a utility to convert left, right, top and 
bottom values to center lat, center lon and zoom. 

 
• A bug has been fixed in DataChoicePanel. When the DataChoicePanel was created using info 

from an existing image, the projection controls were not enabled/disabled correctly. 
 

• The manner in which the color ramp and map color are set within EdgeImage has been 
changed to fix some things that did not always work correctly. Also, when a custom color 
ramp is being used, the color scale list in DataChoicePanel is not enabled. 

 
• Added some code to EdgeImage to turn off blinking when actions occur that change the 

image, such as creating a new image and modifying the color ramp. 
 
 
Version 6.1.1 
 

• A bug was fixed which occasionally caused problems when reading data from a file. The size 
of the buffer that the data were read into was constant. This worked when the number of data 
values was evenly divisible by the buffer size. But if it was not evently divisible, problems 
would occur when reading the last of the data. This has been fixed by using constant buffer 
sizes except when reading the last of the data. In that case, the buffers are only as large as the 
remaining data. 

 
• The SliceChoicePanel was changed to use the ParagraphLayout. This produces a slightly 

improved layout and it simplifies the code slightly. 
 

• The key event problem that occurs with Java 1.4 is resolved. KeyListeners were added to all 
components in the affected windows and dialogs. 

 
• Beginning with Java 1.4, mouse events are handled differently. If a container listens for 

mouse events, it no longer receives the events if the event occurs while the mouse is over a 
child component. This caused a problem in the profile graph. This has been solved by 
moving the mouse listening from ProfileGraphPanel to PlotPanel. When a mouse events 
occurs, the PlotPanel sends a message to the ProfileGraphPanel which then processes the 
event as it did before. 

 
• At one point, a temporary kludge was added to convert water vapor mixing ratios to dew 

point temperatures in order to create horizontal plots of the dew points. This was accidentally 
left in and included in the previous version. The conversion has been removed. 
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Version 6.1 
 

• Added preference panel for data servers. 
 
• Added dialog to inform users of unreachable servers. 

 
• Added the code to allow for custom label files. 

 
• Fixed an array index bug in the title label dialog. 

 
• Added a toolbar to the profile window. 
 
• Replaced menu options of the profile window with a ProfileChoiceDialog. 
 
• Altered the manner in which profile and slice settings are saved. 
 
• Slice and profile windows start out slightly larger. 

 
• Restrict minimum and maximum pressures in slice. 

 
• Changed existing preference dialog setups to conform with other EDGE programs. 
 
• Added the ProfilePrefsDialog. 

 
• Solved problem of lost links to ProfileWindows and SliceWindows. 
 
• Changes to unit labels are now sent to all open ProfileWindows and SliceWindows. 

 
 
 


